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₋ Không biết tạo báo cáo nhanh, chuẩn, đúng ý sếp

₋ Giải quyết công việc quá lâu với các công việc lặp đi lặp lại

₋ Số liệu lộn xộn nên không thể thống kê

₋ Bảng tính nặng nề vì quá nhiều công thức

₋ Số liệu không thể liên kết giữa các bộ phận, phòng ban….

₋ Chưa hiểu rõ bản chất hàm nên không hiểu tại sao kết quả sai

₋ Không biết khi nào thì dùng hàm nào vào công việc đang gặp phải

 Thành thạo Excel để quản lý giấy tờ sổ sách thu chi, quản lý bán hàng kinh doanh, quản 

lý nhân sự, tiền lương, quản lý kho hàng, hàng hóa, quản lý tài chính, phân tích dòng tiền, 

thẩm định giá, lãi vay, các hoạt động của cơ quan doanh nghiệp tổ chức hay công việc cá 

nhân đều được dùng bằng excel.

LỜI MỞ ĐẦU
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 Hãy đến với Tin Học Sao Việt, các vấn đề nan giải trên sẽ được giải quyết một cách bài 

bản, nhanh chóng và chuyên nghiệp, để bạn trở thành nhân viên xuất sắc, một chuyên gia 

trong lĩnh vực thống kê, báo cáo và phân tích.

 Trung tâm Tin Học Sao Việt tự hào là đơn vị hơn 10 năm kinh nghiệm trong lĩnh vực 

đào Thống kê, Báo cáo và phân tích số liệu. Chúng tôi đã đào tạo cho hàng trăm Doanh 

nghiệp, cho hàng ngàn học viên là người đi làm, đồng thời chúng tôi đã cung cấp dịch vụ 

viết phần mềm, file Excel theo yêu cầu với hàng trăm đơn hàng từ các loại hình Doanh 

nghiệp khác nhau… qua đó chúng tôi hiểu rất rõ tầm quan trọng và lợi ích mà bảng tính 

Excel mang lại.

 Trong quá trình biên soạn, không thể tránh được một số thiếu sót, vì vậy sự đóng góp ý 

kiến của Quý học viên cho Trung Tâm sẽ làm cho nội dung tái bản lần sau được hoàn thiện 

hơn.

 Chân thành cảm ơn Quý học viên!

LỜI MỞ ĐẦU
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Có 2 vấn đề mà người học luôn mong muốn khi kết thúc khóa học:

1. Làm sao học xong không bị quên?

2. Học xong làm sao biết áp dụng vào công việc trong thực tế?

Để giải quyết vấn đề trên, chỉ có thể trả lời là: Chúng ta phải có công cụ hỗ trợ.

Công cụ hỗ trợ hiệu quả nhất hiện nay là trí tuệ nhân tạo (AI) và một số ứng dụng Internet.

I. Ứng dụng trí tuệ nhân tạo (AI) phổ biến

1. Chat GPT - Bấm vào đây để sử dụng Chat GPT

2. Copilot - Bấm vào đây để sử dụng Copilot

II. Ứng dụng Internet phổ biến

1. Trình duyệt Chrome - Bấm vào đây để sử dụng Chrome

BÀI 01: TỰ CHỦ CÔNG VIỆC CÙNG AI VÀ INTERNET
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https://chat.openai.com/
https://copilot.microsoft.com/
https://www.google.com.vn/


III. BẮT ĐẦU CÙNG CHAT GPT

Hãy yêu cầu CHAT GPT hướng dẫn các công việc sau: 

1. Khởi động Excel trên máy tính bằng Window + R như thế nào?

2. Excel có những Tab nào?

3. Tab Home trong Excel có những nhóm công cụ nào?

4. Bôi đen vùng từ B2:C4 trong Excel như thế nào?

5. Trộn các ô B2:C4 thành 1 ô bằng công cụ Merge trong Excel như thế nào?

6. Muốn bỏ việc trộn ô thì thực hiện như thế nào?

7. Tạo khung viền cho bảng trong Excel từ địa chỉ B2:E10 bằng công cụ?
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1. Khởi động phần mềm Excel

Nhấn tổ hợp phím Windows + R → Gõ từ “Excel” vào mục Open → OK (hoặc Enter).

2. Lưu 1 Workbook mới tạo ra:

File → Save → Chọn nơi lưu dữ liệu và đặt tên → Bấm chọn Save.
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BÀI 2. KHỞI ĐỘNG VÀ THÀNH PHẦN GIAO DIỆN EXCEL
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3. Thành Phần Giao Diện
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1. Menu

2. Tab (Thẻ)

3. Ribbon (Thanh công cụ)

4. Group Ribbon (Nhóm công cụ)

5. Ribbon (Công cụ)

6. Name Box (Địa chỉ ô)

7. Formula Bar (Thanh công thức)
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1. Sheet (ký hiệu SH)

Mỗi một WB có nhiều SH, nếu coi WB là 1 cuốn sổ, thì SH như những tờ giấy trong cuốn sổ 

đó, một SH là một tờ.

▪ Thêm: Chọn vào dấu (+) dưới khu vực tên SH.

▪ Đặt tên: Chuột phải vào tên → Rename (hoặc nháy đúp vào tên SH).

▪ Xóa: Chuột phải vào tên → Delete.

▪ Sao chép: Giữ chuột trái vào tên đồng thời giữ CTRL và kéo thả.

▪ Ẩn (Hiển thị): Chuột phải vào tên → Hide (Unhide)

▪ Bảo mật (Protect sheet): Chuột phải vào tên → Protect Sheet → Nhập mật khẩu nếu cần

▪ Bỏ bảo mật: Chuột phải vào tên → Unprotect Sheet → Nhập mật khẩu nếu có
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BÀI 3. ĐỐI TƯỢNG VÀ THAO TÁC CƠ BẢN



▪ Di chuyển: Giữ chuột trái vào tên Sheet đồng thời kéo và thả.

▪ Sao chép hoặc di chuyển qua WB khác:

₋ B1: Chuột phải vào tên SH → Move or Copy → tích vào “Creat a copy”

₋ B2: Tại mục “To Book”, chọn tên WB di chuyển tới → OK
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2. Dòng, Cột

Cột (Column) thường ký hiệu bằng chữ cái, dòng (Row) thường ký hiệu bằng con số.

❑ Chọn cột hoặc dòng: Chọn trỏ chuột vào ngay giữa chữ cái hoặc con số.

❑ Chọn nhiều cột, dòng: 

✓ Chọn liên tục: Chọn 1 cột → Giữ Shift đồng thời chọn cột khác;

✓ Chọn không liên tục: Chọn 1 cột → Giữ Ctrl đồng thời chọn cột khác.

❑ Xóa: Chọn cột hoặc dòng → Chuột phải → Delete (Hoặc Ctrl + “dấu -” )

❑ Chèn: Chọn cột, dòng → Chuột phải→ Insert (Hoặc Ctrl + “dấu +” )

❑ Sao chép: Chọn dòng/cột → Chuột phải → Copy (Hoặc Ctrl+C) 

❑ Di chuyển: Chọn dòng/cột → Chuột phải → Cut (Hoặc Ctrl+X)
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❑ Dán: 

✓ C1: Ctrl+V để dán lên cột bất kỳ.

✓ C2: Chuột phải → Insert Copied Cells (hoặc Insert Cut Cells)

❑ Ẩn/Hiển thị (Hide/Unhide): Chọn cột/dòng → Chuột phải → Hide/Unhide.

❑ Giãn dòng, cột: 

✓ Thủ công: Chọn trỏ chuột vào đường chỉ dưới dòng hoặc bên phải cột và kéo thả.

✓ Tự động giãn theo kích cỡ nội dung: Nháy đúp chuột vào đường kẻ (dòng hoặc cột)

✓ Điều chỉnh độ rộng nhiều cột hoặc nhiều dòng bằng nhau:

Quét chọn nhiều dòng hoặc cột → Kéo dãn 1 dòng hoặc 1 cột trong vùng chọn

❑ Cố định Dòng/Cột khi cuộn lên xuống:

✓ Cố định dòng: Chọn dòng phía dưới dòng cần cố định → View → Freeze panes;

✓ Cố định cột: Chọn cột phía bên phải cột cần cố định → View → Freeze panes.
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3. Địa Chỉ Ô:

Địa chỉ ô được ký hiệu bằng Cột và Dòng tương ứng, ví dụ B12 = địa chỉ Ô nằm trên cột B 

và dòng 12.

❑ Chọn: Chọn trỏ chuột vào ô bất kỳ.

❑ Chọn nhiều ô: Chọn 1 ô đầu tiên → Giữ Shift và chọn vào ô cuối trong vùng.

❑ Trộn ô: Chọn các ô cần trộn → Thẻ Home → Nhóm Alignment → Công cụ Merge…

❑ Xuống dòng tự động trong 1 Ô: Chọn Ô →Wrap text.

❑ Xuống dòng thủ công trong 1 Ô: Chuyển dấu nháy tại nơi cần xuống →Alt + Enter

❑ Chỉnh sửa nội dung trong 1 Ô: Chọn Ô → F2 (hoặc Click đúp chuột vào Ô)

❑ Tạo ghi chú (Comment): Chuột phải vào ô, sau đó:

✓ Insert Comment (hoặc Shift+F2) = Chèn ghi chú;

✓ Edit Comment = Sửa Comment;

✓ Xóa: Chọn Delete Comment.
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4. Tên Vùng

Vùng là tập hợp nhiều ô được chọn, được ký hiệu bởi địa chỉ đầu tiên và cuối cùng trong 

vùng chọn, kết hợp dấu “:”, Ví dụ: A1:C10 là vùng từ ô A1 đến ô C10.

❑ Chọn vùng: Chọn trỏ chuột vào giữa 1 ô đầu tiên và quét chọn ra một vùng.

❑ Chọn vùng nhanh: Chọn ô đầu tiên → Giữ SHIFT đồng thời chọn ô cuối cùng, hoặc 

Ctrl+ Shift + End (Chỉ áp dụng cho vùng có dữ liệu).

Để quá trình tính toán và chọn vùng được nhanh và tiện lợi, vùng nên được đặt tên. 

❑ Quy tắc đặt tên: tb + tên Sheet + dấu chấm + tên Cột hoặc dòng hoặc vùng.

Ví dụ: tbNhatKy.MaCtu

❑ Đặt tên vùng: Quét chọn vùng cần đặt tên → Gõ tên vào ô NameBox → Enter

(hoặc chuột phải vào vùng chọn → Define Name).

❑ Gọi nhanh tên vùng: Nhấn phím F3 (hoặc Fn + F3) để gọi các tên vùng đã đặt tên.
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▪ Khi sử dụng công thức chỉ cần gọi tên vùng mà không cần quét chọn vùng.
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▪ Chỉnh sửa vùng:

₋ C1: Thẻ Formulas → Name Manager → Chọn tên vùng cần sửa → Edit.

₋ C2: Hoặc nhấn Ctrl +F3 → Edit.
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5. Xóa dữ liệu trong Excel

• C1: Chọn Ô → Phím Delete.

• C2: Chuột phải → ClearContents.

• C3: Thẻ Home → Nhóm Editing → Chọn công cụ Clear → Chọn các mục sau:

₋ Clear All: Xóa toàn bộ (từ định dạng, nội dung, ghi chú…);

₋ Clear Formats: Chỉ xóa định dạng (Chỉ xóa màu sắc, khung viền, in đậm…);

₋ Clear Contents: Chỉ xóa nội dung;

₋ Clear Comment: Chỉ xóa ghi chú.
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Nhập liệu vào bảng tính Excel theo các yêu cầu sau: 

a. Mười lít rưỡi.

b. Nửa ngày công

c. Một phần tư ngày công

d. Mười nghìn năm trăm lẻ năm đồng.

e. Ngày 13 tháng 09 năm 2024

f. Ngày 12 tháng 11 năm 2024

g. Năm mươi phần trăm

h. Năm mươi phẩy hai lăm phần trăm

 Lưu ý: Học viên nhập liệu mỗi con số vào, ví dụ “Một lít rưỡi” thì nhập 1.5 hoặc 1,5, 

chứ không nhập 1.5l hay 1,5l.
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BÀI 04. KIỂU DỮ LIỆU CƠ BẢN TRONG EXCEL



I. Các Kiểu Định Dạng Thường Dùng

Chọn Ô → Thẻ Home → Nhóm Number → Chọn kiểu định dạng trong khung chọn.
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II.Định Dạng Dữ Liệu Kiểu Số

1. Kiểu số: Number Format

❑Một số lưu ý về định dạng số:

✓ Số nên để căn chỉnh theo mặc định của Excel là bên phải.

✓ Số nên định dạng phần nghìn và thập phân bằng dấu ngăn cách tự động.

✓ Trước khi gõ số thập phân, nên kiểm tra dấu thập phân là dấu “,” hay “.”

✓ Nếu số không nằm bên phải, thì phải kiểm tra lại bằng các cách sau:

Chọn vào ô chứa số → Chọn vào dấu ngăn cách tự động, nếu tự động có phần thập 

phân sinh ra thì định dạng chuẩn.

✓ Nếu số ở dạng Text, dùng Text to Columns để chuyển sang dạng Number

Chọn vùng dữ liệu → Data → Text to Columns → Next (cứ Next) → Finish
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2. Kiểu ngày tháng đầy đủ: Shordate

▪ Một số lưu ý về định dạng Date:

₋ Ngày tháng về bản chất là một con số, vì vậy nó mang các đặc điểm của dạng Number, 

nhưng được định dạng kiểu khác Number.

₋ Định dạng ngày tháng phải gõ theo đúng định dạng của hệ thống.

₋ Khi chọn ô và chọn định dạng kiểu General hoặc dấu ngăn cách thập phân tự động, nếu 

nó chuyển về dạng số là chuẩn định dạng Date, còn không là đang dạng Text.

₋ Để chuyển nhanh sang dạng Date, dùng phép nhân số đó với 1 sang 1 cột khác, sau đó 

copy và dán dạng giá trị ngược lại vào cột đó, rồi định dạng lại dạng Date.
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3. Định dạng kiểu chuỗi: Text

₋ Kiểu Text nên căn chỉnh về bên trái theo mặc định Excel.

₋ Để chuyển định dạng số sang kiểu Text, sử dụng hàm TEXT.

₋ Các số khi cắt từ một chuỗi, sẽ cho ra kiểu TEXT.

₋ Để kiểm tra định dạng TEXT sử dụng hàm ISTEXT.

▪ Lưu ý:

• Sao chép định dạng nhanh: dùng công cụ Format Painter.

• Căn chỉnh định dạng hệ thống: 

Control Panel → Clock and Region → Change…Formats → Additional Settings.. →

(Numbers = Định dạng số; Time = Định dạng giờ phút giây; Date = Định dạng ngày 

tháng năm).
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4. Ôn Tập Kiến Thức Về Định Dạng Và Kiểu Dữ Liệu 

A. Khi gõ số dạng thập phân, cần chú ý điều gì sau?

a. Cứ dấu thập phân là dấu phẩy (,).

b. Cần xác định dấu thập phân đang sử dụng là gì mới gõ.

B. Để nhận biết dấu thập phân đang sử dụng, thực hiện cách nào sau?

a. Vào hệ thống của máy tính để kiểm tra.

b. Gõ một con số (ví dụ gõ 10000) vào Excel, sau đó chọn dấu ngăn cách tự động để nhận 

biết.

C. Khi gõ số 12,500,120.54 vào Excel, cần chú ý điều gì?

a. Cứ gõ và dùng dấu ngăn cách như số trên, với dấu phẩy (,) là dấu ngăn phần nghìn.

b. Phải xác định dấu ngăn cách thập phân trước khi gõ.
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D. Khi nhập liệu số, dấu hiệu nhận biết nhập liệu đúng định dạng dữ liệu kiểu số là 

gì?

a. Số sau khi gõ tự nằm bên phải của Ô.

b. Tự có dấu ngăn cách phần nghìn nếu gõ số có 3 chữ số và chọn dấu ngăn cách tự động.

c. Số sau khi gõ nằm bên trái của Ô.

d. Cả a và b đều đúng.

E. Khi gõ dữ liệu dạng ngày tháng năm, cần chú ý điều gì sau?

a. Cứ gõ ngày rồi đến tháng rồi đến năm

b. Cần xem định dạng hệ thống kiểu ngày trước tháng hay tháng trước ngày, sau đó mới gõ
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F. Để nhận biết dữ liệu dạng ngày tháng năm gõ đã đúng chưa, chọn điều nào sau?

a. Sau khi gõ dữ liệu nằm bên phải.

b. Sau khi gõ, khi chọn ô đó và chọn vào dấu ngăn cách tự động nó sẽ biến thành con số.

G.Khi nhận được một tờ hóa đơn có ghi ngày là 31/12/2022, sẽ nhập liệu thế nào?

a. Kiểm tra hệ thống xem ngày trước hay tháng trước rồi mới gõ.

b. Vào hệ thống máy tính để chỉnh sửa định dạng thời gian về dạng dd/mm/yyyy rồi mới 

gõ.

c. Cả hai ý trên đều đúng.
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I. Tạo Bảng

▪ Tạo, định dạng khung viền và màu sắc:

• C1: Quét chọn vùng cần tạo → Chọn công cụ Border →All Border

BÀI 05. TẠO VÀ TRÌNH BÀY BẢNG TÍNH
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• C2: Quét chọn vùng cần tạo→ Chuột phải→ Format cells→ Border. 
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II.Sao Chép Định Dạng Nhanh Với Format Painter

Để tạo nhanh các định dạng giống nhau (màu sắc, khung viền…), thì ta nên sử dụng công 

cụ có sẵn Format painter:

₋ B1: Chọn vùng có định dạng cần sao chép → Thẻ Home → Bấm chọn vào công cụ 

Format Painter, xuất hiện con trỏ kèm cái chổi.

₋ B2: Bấm chọn ô đầu tiên của vùng cần dán.
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III.Căn Chỉnh Nội Dung Trong Bảng

Chọn ô cần căn chỉnh, sau đó chọn một trong các công cụ sau:
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IV.Các Bước Nên Thực Hiện Trước Khi Tạo Bảng Tính

1. Xác định hướng giấy và khổ giấy chuẩn A4 (hoặc A3, A5…)

▪ Vào thẻ Page layout và chọn theo các mục sau:

• Orientation: Hướng giấy 

• Size: Khổ giấy

2. Chọn Font chữ “Time New Roman” cho toàn bộ bảng tính.

3. Kẻ bảng, hoàn thiện tiêu đề, chỉnh độ rộng các cột phù hợp nội dung.

4. Hoàn thiện các nội dung liên quan sau khi đã hoàn thiện các bước trên.

5. Định dạng dữ liệu cho các cột trước khi nhập liệu.
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V. Thực Hành
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CÔNG TY TNHH GIÁO DỤC TIN HỌC SAO VIỆT

MST: 360.370.8616

ĐT: 0812.114.345      Website: blogdaytinhoc.com

Số lệnh

LỆNH ĐIỀU ĐỘNG NỘI BỘ

Căn cứ tình hình sản xuất, kinh doanh giữa các chi nhánh của Công Ty, nay BGĐ yêu cầu BP Kế

toán kho, BP Kho chuyển hàng từ chi nhánh……………………….. Tại địa chỉ………………….

…………………………………….. Đến chi nhánh ……………………………tại địa chỉ ……..

…………………………………………………………………..

Mã hàng Tên hàng SL xuất Ghi chú

Biên Hòa, ngày……..tháng…...…năm…………..

Thủ kho Kế toán kho Ban giám đốc
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MST: 360.370.8616

ĐT: 0812.114.345      Website: blogdaytinhoc.com

SỔ QUỸ TIỀN MẶT
Loại quỹ:……………..

Ngày 

Ghi sổ

Ngày 

Chúng từ
Số chứng từ Nội dung Thu Chi Tồn Ghi chú

Sổ này có…..trang, từ trang….. Đến trang………..

Ngày mở sổ:

Biên Hòa, ngày……..tháng…...…năm…………..

Thủ quỹ Kế toán trưởng Giám đốc
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I. Cài Đặt Máy In

Vào File→ Print hoặc nhấn tổ hợp phím Ctrl+P

 Xem them hình ảnh trong trang sau.

BÀI 06. KỸ NĂNG IN ẤN
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1 Pritnt: Lệnh in

2 Số bản in

3 Chọn máy in

4 In từ trang số.. Đến số…

5 In kiểu 2 mặt hoặc 1 mặt

6 Hướng giấy

7 Khổ giấy

8 Tự động dồn cột hoặc dòng vào 1 trang in

9 Hiển thị khung lưới chỉnh trang in

10 Hiển thị và xem trang in



 Lưu ý: Khi thực hành các thao tác liên quan in ấn, học viên phải bật chế độ in 

(Ctrl + P) để kiểm tra lại các thao tác đã đúng chưa.
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II.Tạo Vùng In Cố Định

Khi in bảng tính, chỉ có duy nhất vùng được cố định in ra mà thôi.

▪ Tạo vùng in: Chọn vùng → Page layout → Print Area → Set Print Area.

▪ Thêm vùng in: Chọn vùng cần thêm (Vùng này không đè lên vùng đã cố định trước đó) 

→ Page layout → Print Area →Add To Print Area.

▪ Để xóa in: Chọn vùng → Page layout → Print Area → Clear Print Area.
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III.Dồn Trang In Tự Động

Khi trang in có một số ít cột hoặc dòng vượt quá trang in hiện tại, để căn chỉnh nhanh cho 

vào trong trang ta sử dụng chức năng có sẵn trong Excel, tuy nhiên phải đảm bảo là bạn 

đã cố gắng tự căn chỉnh bằng tay.

▪ File → Print → tại mục “Scale to fit” nằm gần chữ Page Setup lựa chọn theo hình sau:
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IV.Nhắc Lại Tiêu Đề Dòng, Cột Khi In

Khi bảng tính có nhiều trang, dòng tiêu đề nên được nhắc lại cho các trang sau.

▪ Các bước thực hiện:

Thẻ Page layout → Print Titles → thẻ Sheet → bấm chuột trái vào “Row to repeat at top”, 

sau đó di chuyển chuột ra ngoai bảng Excel, di chuyển con trỏ màu đen vào dòng muốn 

nhắc lại khi in.

Xem thêm hình sau:
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IV.Nhắc Lại Tiêu Đề Dòng, Cột Khi In (tt):
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V. Đánh Số Trang

Một bảng tính có nhiều trang in, nên đánh số trang để dễ quản lý.

▪ Các bước thực hiện: Thẻ Page layout → Print Titles → Header/Footer → Custom 

Footer:
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V. Đánh Số Trang

Một bảng tính có nhiều trang in, nên đánh số trang để dễ quản lý.

▪ Các bước thực hiện: Thẻ Page layout → Print Titles → Header/Footer → Custom

Header :
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I. Lọc Cơ Bản

Để những đối tượng cần kiểm tra được hiển thị, ta dùng chức năng lọc dữ liệu, ví dụ để

kiểm tra những người có tên Trinh, nếu đi dò từng dòng sẽ rất lâu, nhưng nếu lọc ra riêng

tất cả những người tên Trinh thì kiểm tra rất dễ.

1. Các bước lọc dữ liệu:

▪ B1: Quét chọn tất cả vùng dữ liệu, bao gồm cả tiêu đề.

▪ B2: Data → Filter.

▪ B3: Để lọc một đối tượng, chọn vào nút lọc trên

đầu cột,gõ từ gợi ý vào ô tìm kiếm (Search) tại mục

số 4 sau đó nhấn OK.

BÀI 07: LỌC VÀ SẮP XẾP DỮ LIỆU TRONG EXCEL
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2. Một số dạng lọc cơ bản:

▪ Text Filter: Khi lọc cột dạng chuỗi:

₋ Equals: Lọc chính xác một từ.

₋ Does Not Equal: Lọc các từ khác biệt 1 từ quy ước.

₋ Begins With: Lọc bắt đầu bằng 1 từ.

₋ End With: Lọc kết thúc với 1 từ.

₋ Contains: Lọc các đối tượng có chứa từ cần lọc.

₋ Does Not Contain: Lọc từ cần lọc không chứa từ quy ước.
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▪ Number Filter: khi lọc cột số:

₋ Equals: = số quy ước.

₋ Does Not Equal: <> số quy ước.

₋ Greater Than: > số quy ước.

₋ Greater Than Or Equal: >=số quy ước.

₋ Less Than: < số quy ước.

₋ Less Than Or Equal To : <= số quy ước.

₋ BetWeen: Lọc trong một khoảng quy ước.

₋ Top 10: n số lớn nhất, hoặc nhỏ nhất.

₋ Above Average: Các số lớn hơn giá trị trung bình cộng.

₋ Below Average: Các số nhỏ hơn giá trị trung bình cộng.
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II.Sắp Xếp Cơ Bản

1. Sắp xếp một cột:

▪ B1: Thao tác theo B1 và B2 của lọc dữ liệu.

▪ B2: Bấm vào biểu tượng lọc, chọn Sort A→Z 

hoặc Sort Z→A.

2. Sắp xếp nhiều cột:

▪ B1: Thao tác theo B1 và B2 của lọc dữ liệu.

▪ B2: Data→ Công cụ Sort (Gần công cụ Filter).

₋ Add Level: Thêm cột cần sắp xếp.

₋ Tại bảng hiện ra ở mục số 4, kích chọn cột cần sắp xếp sau đó nhấn OK.

Xem thêm hình ảnh trang sau:
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I. Tìm Kiếm Trong Excel

Để tìm kiếm một từ, một con số…, ta dùng chức năng Find sẵn có trong Excel.

Các bước thực hiện:

▪ B1: Nhấn Ctrl+ F.

▪ B2: Gõ từ cần kiếm trong ô Find what.

▪ B3: Chọn Find Next.

₋ Match case: Tìm từ hoa thường.

₋ Match entire cell contents:

Tìm từ chính xác với từ trong ô tìm kiếm.

BÀI 08: TÌM KIẾM VÀ THAY THẾ TRONG EXCEL
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II.Thay Thế Trong Excel

Để thay thế một từ, một con số… bằng một từ hoặc một con số khác, ta dùng chức năng 

Replace sẵn có trong Excel.

Các bước thực hiện:

▪ B1: Nhấn Ctrl+ F.

▪ B2: Chọn thẻ Replace.

▪ B3: Chọn các phép thay thế sau:

₋ Replace: Thay thế từng từ.

₋ Replace all: Thay thế toàn bộ các từ Tìm thấy.
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I. Một Số Chú Ý Trước Khi Thực Hiện Hàm:

1. Phải nắm rõ yêu cầu thực tế của công việc đang làm

▪ Bước này cần phải biết làm 1 ví dụ nhỏ bằng thủ công.

▪ Xác định trình tự từng bước của việc làm bằng tay.

2. Xác định hàm sẽ sử dụng để phục vụ cho công việc ở bước 1 

▪ Bước này, phải mô tả được yêu cầu bài toán theo một cách tổng quát và phổ thông nhất.

▪ Mở Google và tra cứu với cụm từ “Hàm dùng để” + “Yêu cầu”.

Ví dụ: “Hàm dùng để tìm kiếm thông tin trong Excel là hàm gì?”.

BÀI 09: KIẾN THỨC CƠ BẢN VỀ HÀM TRONG EXCEL
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3. Cách sử dụng hàm

▪ Phải nắm được ý nghĩa của hàm (hàm này dùng để làm gì?).

▪ Phải nắm được cấu trúc của hàm .

₋ Tên hàm phải đúng theo danh sách gợi ý.

₋ Hàm có bao nhiêu tham số.

₋ Nhiệm vụ từng tham số là gì.

₋ Dấu ngăn cách tham số phải theo hướng dẫn của hàm.
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I. Các Phép Tính Cơ Bản

Cộng (+), Trừ (-), Nhân (*), Chia (/)

II.Quy Tắc Thực Hiện Phép Tính Trong Excel

Nội dung phép tính → Enter, ví dụ: =3+2 → Enter sẽ ra kết quả là 5

III.Thực Hiện Phép Tính Với Địa Chỉ Ô

Để thực hiện tính toán trong Excel, thực hiện chủ yếu trên địa chỉ ô, ví dụ: =A1+A5+B13

IV.Sao Chép Công Thức Trong Excel (tt)

▪ C2: Chọn ô có công thức, di chuyển chuột vào góc dưới bên phải của ô đang chọn, xuất 

hiện dấu cộng màu đen  → giữ chuột trái và kéo

▪ C3: Quét chọn từ ô đầu tiên có công thức đến hết vùng cần sao chép, nhấn Ctrl+D (sao 

chép từ trên xuống) hoặc Ctrl+ R (sao chép từ trái qua phải)

BÀI 10: TÍNH TOÁN VÀ CÔNG THỨC TRONG EXCEL
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IV.Sao Chép Công Thức Trong Excel (tt)

▪ C2: Chọn ô có công thức, di chuyển chuột vào góc dưới bên phải của ô đang chọn, xuất 

hiện dấu cộng màu đen  → giữ chuột trái và kéo

▪ C3: Quét chọn từ ô đầu tiên có công thức đến hết vùng cần sao chép, nhấn Ctrl+D (sao 

chép từ trên xuống) hoặc Ctrl+ R (sao chép từ trái qua phải)

V. Công Thức Trong Excel

Công thức là một tập hợp các phép tính, biểu thức toán học, hàng số, các biến số… Các 

phép tính cơ bản gồm: + (Cộng), - (Trừ), * (Nhân), / (Chia)

Ví dụ: Tại ô A3, nhập công thức =A1+A2-A5+25+SUM(A8:C9) → Enter
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Hàng số HàmBiến=Địa chỉ ô



VI.Địa Chỉ Tương Đối Và Tuyệt Đối Trong Excel

Một ô tính trong Excel đều được gắn với một cái tên gọi là địa chỉ ô, địa chỉ được ký hiệu 

bằng cách ghép tên cột với số dòng tương ứng. Ví dụ: Ô nằm trên cột B dòng số 2 thì địa

chỉ ký hiệu là B2

▪ Địa chỉ tương đối: là địa chỉ bị thay đổi khi sao chép công thức từ ô này sang ô khác

▪ Địa chỉ tuyệt đối: là địa chỉ không bị thay đổi khi sao chép công thức sang ô khác

₋ Để cố định địa chỉ, dùng dấu $, $ trước chữ cái là cố định cột, trước số là cố định dòng

₋ Phím tắt nhanh để cố định địa chỉ trong công thức là dùng: F4.

Ví dụ: Tại ô B2 nhập số 5, sau đó thực hiện theo 2 yêu cầu sau đây:

1. Tại A1 gõ công thức “=B2” → Copy ô A1 sang ô C5 thì giá trị ô C5 cho kết quả?;

2. Tại A1 gõ công thức “=$B$2” → Copy ô A1 sang ô C5 thì giá trị ô C5 cho kết quả?.
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1. Trước khi được giao một công việc tính toán, cần phải làm gì trước?

a. Xác định hàm gì sẽ sử dụng để tính toán.

b. Cần nắm rõ yêu cầu thực tế công việc là gì.

2. Sau khi xác định được yêu cầu cụ thể của công việc, nên làm gì trước?

a. Đi tra tìm hàm sử dụng cho công việc đang cần tính toán.

b. Tư duy bằng phương pháp thủ công và trình tự tính toán trước.

3. Cấu trúc hàm gồm những thành phần nào?

a. Tên hàm và tham số.

b. Dấu ngăn cách các tham số.

c. Cả 2 ý trên.

ÔN TẬP KIẾN THỨC CƠ BẢN VỀ HÀM
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4. Trước khi sử dụng hàm, cần chú ý điều gì sau?

a. Hàm đang sử dụng có nhiệm vụ là gì?

b. Hàm đang sử dụng có bao nhiêu tham số?

c. Ý nghĩa từng tham số là gì?

d. Dấu ngăn cách tham số là dấu gì?

e. Cả 4 ý trên.

5. Có các hàm như sau, trong mỗi hàm, hãy cho biết?

a. Các hàm dưới đây có bao nhiêu tham số và dấu ngăn cách tham số là dấu gì?
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LƯU Ý QUAN TRỌNG

CHƯA ĐỌC HOẶC CHƯA HIỂU BÀI 9 VÀ BÀI 10, TUYỆT ĐỐI 

KHÔNG ĐƯỢC QUA

KIỂM TRA TRẮC NGHIỆM KỸ CÀNG
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I. Hàm Tính Tổng SUM

Cú pháp: = SUM(quét chọn vùng cần tính)

Lưu ý: Để tính tổng nhanh, có thể áp dụng 1 số thủ thuật sau: Đặt con trỏ chuột vào ô 

cần tính tổng hoặc quét chọn vùng bao gồm cả dòng cần tính tổng hoặc cột cần tính tổng 

hoặc cả dòng và cột cần tính tổng → Nhấn vào biểu tượng AutoSum hoặc nhấn Alt = . 

Tuy nhiên đảm bảo không có ô trống hoặc dòng trống nào trong vùng tính tổng.

II.Hàm Đếm COUNT, COUNTA, COUNTBLANK

Cú pháp: 

= COUNT (Vùng cần đếm) → Đếm số ô có chứa ký tự dạng số

= COUNTA (Vùng cần đếm) → Đếm số ô không rỗng

= COUNTBLANK (Vùng cần đếm) → Đếm các ô rỗng

Chú ý: Nếu đếm các kiểu ký tự dạng chữ cái hay ký tự đặc biệt, phải để trong dấu ngặc 
kép, ví dụ: COUNT (a,b,c,1) hàm này sẽ báo lỗi, chúng ta phải =COUNT (“b”,”c”,1)

BÀI 11: HÀM TÍNH TỔNG VÀ ĐẾM
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I. Sử Dụng Hàm Tìm Giá Trị Lớn Nhất, Nhỏ Nhất

▪ Hàm MIN, tìm ra giá trị nhỏ nhất trong dãy số, cú pháp: 

= MIN(quét chọn vùng)

▪ Hàm MAX, tìm ra giá trị lớn nhất trong dãy số, cú pháp: 

= MAX(quét chọn vùng)

II.Sử Dụng Hàm Tính Giá Trị Trung Bình Cộng

▪ Hàm AVERAGE, tính trung bình cộng, cú pháp:

= AVERAGE(Quét chọn vùng cần tính)

BÀI 12: HÀM TÌM GIÁ TRỊ LỚN NHẤT, NHỎ NHẤT VÀ 

TÍNH TRUNG BÌNH CỘNG
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I. Hàm Tính Tổng Phụ Subtotal

Hàm này thường áp dụng khi bảng tính có các nhóm, nó có 2 điểm đặc biệt:

 Số liệu tổng tự động cập nhật khi thêm nhóm mới.

 Tự động trừ đi các dòng bị ẩn.

 Tổng phụ không thống kê các tổng con.

▪ Cú pháp: 

= SUBTOTAL(Chỉ số hàm, Quét chọn vùng cần thống kê)

▪ Các chỉ số hàm tương ứng:

• Từ 1→11 là thống kê cả giá trị bị ẩn.

• 101→ 111 là chỉ thống kê giá trị được hiển thị.

BÀI 13: HÀM TÍNH TỔNG PHỤ
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1. Để tính tổng cho một vùng dữ liệu, sử dụng cách nào?

a. Dùng phép tính cộng để tính tổng các Ô trong vùng dữ liệu với nhau

b. Dùng Hàm SUBTOTAL để tính

c. Dùng Hàm SUM để tính

2. Để đếm có bao nhiêu ô chứa dữ liệu dạng số?

a. Dùng hàm SUBTOTAL để đếm

b. Dùng hàm COUNTA để đếm

c. Dùng hàm COUNT để đếm

ÔN TẬP KIẾN THỨC BÀI 13
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3. Để đếm có bao nhiêu ô có chứa dữ liệu dung hàm gì?

a. Dùng hàm SUM

b. Dùng hàm COUNTBLANK

c. Dùng hàm COUNTA

4. Để đếm có bao nhiêu ô không chứa dữ liệu dùng hàm gì?

a. Dùng hàm COUNT

b. Dùng hàm SUM

c. Dùng hàm COUNTBLANK

5. Để tính tổng cho một vùng dữ liệu, sử dụng cách nào?

a. Dùng phép tính cộng để tính tổng các Ô trong vùng dữ liệu với nhau

b. Dùng Hàm Count để tính

c. Dùng Hàm SUM để tính
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5. Để đếm có bao nhiêu ô chứa dữ liệu dạng số?

a. Dùng hàm SUM để đếm

b. Dùng hàm COUNTA để đếm

c. Dùng hàm COUNT để đếm

6. Để đếm có bao nhiêu ô có chứa dữ liệu dung hàm gì?

a. Dùng hàm SUM

b. Dùng hàm COUNTBLANK

c. Dùng hàm COUNTA

7. Để đếm có bao nhiêu ô không chứa dữ liệu dùng hàm gì?

a. Dùng hàm COUNT

b. Dùng hàm SUM

c. Dùng hàm COUNTBLANK
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▪ Hàm DAY, MONTH, YEAR: Trả về ngày, tháng, năm tương ứng trong chuỗi

= DAY(Chuỗi dạng Date), các hàm còn lại tương tự.

▪ Hàm HOUR, MINUTE, SECOND: Lấy ra giờ hoặc phút hoặc giây trong chuỗi.

= HOUR(Chuỗi chứa số dạng Date có chứa giờ), các hàm còn lại tương tự.

▪ Hàm DATE, TIME: Là hàm nối các thời gian riêng lẻ về một chuỗi.

= DATE(Năm, tháng, ngày) 

= TIME(Giờ, phút, giây)

▪ Hàm WEEKDAY trả về ngày thứ mấy trong tuần

= WEEKDAY(Chuỗi số dạng Date, k) thường là k = 1, tướng ứng Chủ nhật là số 1.

BÀI 14: HÀM XỬ LÝ THỜI GIAN
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▪ Hàm LEFT, RIGHT: Lấy ra các ký tự bên trái hoặc bên phải của một chuỗi ký tự, Cú 

pháp:

= LEFT(Chuỗi có ký tự muốn cắt, số ký tự cần cắt)

= RIGHT(Chuỗi có ký tự muốn cắt, số ký tự cần cắt)

▪ Hàm MID: Cắt ra các ký tự bất kỳ của một chuỗi ký tự, Cú pháp: 

= MID(Chuỗi có ký tự muốn cắt, vị trí cắt đếm từ trái qua, số ký tự cần cắt)

▪ Hàm LEN: Đếm số ký tự trong một chuỗi, cú pháp:

= LEN(Chuỗi có ký tự muốn đếm)

▪ Hàm TRIM: Xóa các ký tự trắng vô nghĩa trong chuỗi, Cú pháp:

= TRIM(Chuỗi chứa ký tự cần xử lý)

Ví dụ: SAO   VIỆT→ SAO VIỆT

BÀI 15: HÀM XỬ LÝ CHUỖI
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▪ Phép nối chuỗi &: Nối các từ với nhau.

= A&B →AB… với A và B là các từ hoặc các chuỗi ký tự bất kỳ.
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▪ Hàm INT: Lấy phần nguyên từ số thập phân. Cú pháp:

= INT(Số thập phân)

▪ Hàm ROUND: Làm tròn số, phần thập phân từ 1- 4 sẽ được tính là 0, phần thâp phân 

từ 5-9 sẽ được quy tròn là 1 đơn vị và cộng vào kết quả. Cú pháp:

=ROUND(Số thập phân, phần thập phân cần lấy bao nhiêu số)

▪ Hàm MOD: Lấy số dư. Cú pháp:

=MOD(Số bị chia, số chia)

▪ Hàm VALUE: Chuyển ký tự số dạng Text sang Number. Cú pháp:

=VALUE(ký tự số dạng Text)

BÀI 16: HÀM XỬ LÝ SỐ
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I. Hàm Xử Lý Lỗi

Hàm IFERROR: Dùng để thay thế giá trị bị lỗi bằng 1 giá trị nào đó, cú pháp:

=IFERROR(Ô cần kiểm tra, giá trị muốn trả về nếu lỗi)

BÀI 17: HÀM XỬ LÝ LỖI
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▪ Hàm VLOOKUP, HLOOKUP

Tìm kiếm thông tin liên quan đến 1 đối tượng trong vùng tham chiếu, cú pháp:

= VLOOKUP(Đối tượng đi dò tìm, Vùng dò tìm, Cột số mấy có thông tin cần lấy, 0)

= HLOOKUP(Đối tượng đi dò tìm, Vùng dò tìm, Dòng số mấy có thông tin cần lấy,0)

• Lưu ý:

₋ Tham số cuối cùng nếu là 0 là tìm kiếm tuyệt đối, tức là thông tin dò tìm có mặt tại hai 

bảng phải giống nhau về định dạng và giá trị, còn nếu 1 là tìm kiếm tương đối. Chương 

trình Excel nâng cao sẽ nghiên cứu sâu hơn về hàm tham số 1.

₋ Giá trị dò tìm trong hàm VLOOKUP luôn bắt đầu từ dò tìm tại cột đầu tiên trong bảng 

dò tìm.

₋ Vùng tìm kiếm luôn phải cố định.

BÀI 18: HÀM TÌM KIẾM (DÒ TÌM)
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I. Phép Kiểm Tra Điều Kiện

▪ Bài toán có điều kiện thì ta phải kiểm tra.

▪ Để kiểm tra 1 ĐK ta chỉ cần so sánh đối tượng cần kiểm tra với điều kiện đặt ra.

Ví dụ: Để kiểm tra mặt hàng chuối thuộc nhóm X phải không, ta làm như sau:

=B4=“X” → Enter.

Lưu ý: Để ktra ĐK, sử dụng 6 phép so sánh sau: =, >, <, >=, <=,<>

BÀI 19: PHÉP KIỂM TRA VÀ HÀM CÓ ĐIỀU KIỆN
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II.Hàm Có Điều Kiện If

Khi kết quả trả về phụ thuộc vào kết quả của phép kiểm tra điều kiện ta dùng hàm IF.

Cú pháp:

=IF(Kiểm tra điều kiện, Kết quả muốn trả về nếu phép ktra đúng, kết quả muốn trả về nếu 

phép ktra sai)

=IF(logical_test, [value_if_true], [value_if_false]) :

₋ logical_test: Kiểm tra điều kiện (Biểu thức so sánh)

₋ [value_if_true]: Kết quả muốn trả về khi kiểm tra điều kiện đúng(True)

₋ [value_if_false]: Kết quả muốn trả về khi kiểm tra điều kiện sai (False)

▪ Một số ví dụ thực tế về hàm IF:

T r a n g 7 6Biên soạn: Bạch Xuân Hiến TRUNG TÂM ĐÀO TẠO TIN HỌC SAO VIỆT

Nếu điểm thi là 10 Thì
Con được Thưởng 1 chiếc xe
đạp điện

Ngược lại Con phải tính 1 năm có bao nhiêu giờ

Nếu điểm thi trên 5 Thì Bạn sẽ đậu tốt nghiệp Ngược lại
Bạn phải tìm kiếm có trong danh sách
ưu tiên không
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1. Để đếm số ô chứa dữ liệu dạng số dùng hàm gì sau?

a. COUNTA b. SUM c. MID d. COUNT

2. Để lấy ra ký tự bất kỳ trong chuỗi dung hàm gì sau?

a. VLOOKUP b. HLOOKUP c. RIGHT d. MID

3. Để tìm kiếm thông tin cho một đối tượng cho trước ở một bảng, mà đối tượng này 

có mặt ở một bảng chứa thông tin khác, có thể dùng hàm gì sau đây?

a. MID b. SUBTOTAL c. VLOOKUP d. HLOOKUP

4. Để lấy ra ký tự bên trái của một chuỗi ký tự, có thể dùng hàm gì sau đây?

a. MID b. RIGHT c. LEFT d. VLOOKUP

5. Khi bài toán có kết quả trả về phụ thuộc điều kiện cho trước, dung hàm nào sau?

a. WEEKDAY b. LEFT c. IF d. SUM

BÀI 20: BÀI THI TỔNG KẾT CUỐI KHÓA
(12 Câu Lý Thuyết Làm Vào Vở, Thực Hành Làm Theo File Excel Trên Website)
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6. Để trả về kết quả là giá trị lớn nhất trong một vùng dữ liệu, sử dụng hàm gì?

a. MID b. MIN c. COUNT d. MAX

7. Để trả về kết quả là giá trị nhỏ nhất trong vùng dữ liệu, sử dụng hàm gì?

a. MAX b. DAY c. MIN d. COUNTA

8. Để trả về kết quả là một ngày trong tháng, sử dụng hàm gì?

a. MONTH b. WEEKDAY c. DAY d. SECOND

9. Để làm tròn một số, dùng hàm gì?

a. MONTH b. VALUE c. ROUND d. INT

10.Để lấy ra phần nguyên từ một số thập phân, sử dụng hàm gì sau?

a. MID b. RIGHT c. LEFT d. INT

11.Để tính trung bình cộng của một vùng dữ liệu, có thể sử dụng hàm gì?

a. SUBTOTAL b. LEFT c. AVERAGE d. SUM
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12.Để trả về kết quả là giá trị lớn nhất trong một vùng dữ liệu, có thể sử dụng hàm 

gì?

a. MID b. SUBTOTAL c. COUNT d. MAX

13.Bài thi thực hành cuối khóa.
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